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About This Guide
This topic contains important information about the purpose, content, context, and intended audience for this document.

Product Documentation

This document is part of the Niagara technical documentation library. Released versions of Niagara software include a complete 
collection of technical information that is provided in both online help and PDF format. The information in this document is 
written primarily for Systems Integrators. To make the most of the information in this book, readers should have some training or 
previous experience with Niagara software, as well as experience working with JACE network controllers.

Document Content

This content is designed to help systems integrators, engineers, and technical users efficiently configure, manage, and 
troubleshoot Touchscreen Room Controllers within the Niagara Framework. This guide provides both conceptual background 
and practical workflows, ensuring that users can quickly understand the capabilities of the Touchscreen Room Controller Niagara 
Engineering Module and apply them in real-world scenarios.

Each individual "Touchscreen Room Controller Niagara Engineering Module" topic is included as a separate chapter in the print 
or PDF rendering of this guide.

Document Change Log

This log provides the date this document was released and lists any subsequent document updates that have occurred.

April 20, 2026

•	 Initial document release.

Related Documentation

Additional information is available in the following documents.

•	 Getting Started with Niagara

https://www.se.com/myschneider
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Chapter 1. Touchscreen Room Controller Niagara 
Engineering Module Overview and Components

This topic provides an overview of the Touchscreen Room Controller Engineering Module and its role within Niagara. It introduces 
the major Touchscreen Room Controller components, BACnet network structure, and how Touchscreen Room Controller objects 
integrate into a Niagara station. Use this topic to understand the context, purpose, and foundational elements of controller-based 
engineering.

Touchscreen Room Controller N4 Tool Installation

The Touchscreen Room Controller Engineering Module is compatible with Niagara versions 4.14 and 4.15.

Set Up

The Touchscreen Room Controller Niagara Engineering Module comes with the following modules:

•	 trcConnect-rt.jar

•	 trcConnect-wb.jar

Install these modules in your Niagara installation folder, e.g., C:\Niagara\(Niagara Version)\modules.

To install the Touchscreen Room Controller Niagara Engineering Modules on a JACE, connect the JACE to your laptop, open the 
JACE platform, and use the software manager tool to transfer modules to JACE and restart the JACE. For more information on 
software manager, Please refer to the Niagara help.

Refer to the new station wizard help to create a new station in Niagara. Make sure to set the passphrase to the newly created 
station before transferring the station to the daemon home. Refer to the “Bog Protection” section in Niagara help for more 
details.

Functionality

Discover and Add a Controller to Niagara

Discover the Touchscreen Room Controllers from Network and add them to Niagara. Please refer to the “Discover and Add 
Controllers” section to add an existing controller to Niagara.

Discover and Add Config Objects

Once the controller is added to Niagara, discover the existing objects from the controller and add them to the Niagara database. 
Please refer to the “Discover and Add Config Objects” section to add existing objects.

Various Commands on Objects

Various commands like copy, paste etc. are available when right-clicking on the config object/folder. Please refer to the “Various 
Commands on Objects” section for more information.

Upload Objects

Upload the value of various properties of the existing object from the controller. Please refer to the “Upload Config Objects” 
section to upload the object's properties from the controller.

Download Objects

Download the value of various properties of the existing object to the controller. Please refer to the “Download Config Objects” 
section to download the object's properties to the controller.

https://www.se.com/myschneider
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Upload All Objects

Uploads all the existing objects from the controller to Niagara. Please refer to the “Upload All Config Objects” section to upload 
all the the objects from the controller to Niagara.

Download All Objects

Downloads all the existing objects from Niagara to the controller. Please refer to the “Download All Config Objects” section to 
download all the objects from Niagara to the controller.

Modify the configuration

Change the properties of the various objects in the controller. Please refer to the “Modify Configuration” section to edit an 
object's properties.

Components

Touchscreen Room Controller Components include devices associated with a module. The user can drag them to TRC Manager 
or BACNet Network

Descriptions included in the following topics appear as context-sensitive help topics when accessed by:

•	 Right-clicking on the object and selecting View > Guide Help

•	 Clicking Help > Guide On Target

Related Links 

Controllers:

•	 SXW-TRC-3500-Bcc-W

•	 SXW TRC 3500 Bcc X

•	 SXW TRC 6500 Bcc W

•	 SXW TRC 6500 Bcc X

Analog:

•	 Analog input

•	 Analog output

•	 Analog hardware output

•	 Analog value

•	 Analog Hardware value

•	 Analog lua value

Binary:

•	 Binary input

•	 Binary output

•	 Binary value

Multti-state:

•	 MultiState input

•	 MultiState value

String Value:

•	 String Value

Schedule:

•	 Enumerated Schedule

•	 Calendar

Lua Program:

•	 LUA Program

File:

•	 Lua File

•	 Log File

•	 Image File

•	 Upgrade package

Network Port:

•	 Network Port

https://www.se.com/myschneider
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Touchscreen Room Controller BACnet Network

BACnet Network is the entry point to the Touchscreen Room Controller configuration.

Drop the BACnet Network under Drivers container, configure its BACnet Comm, and Local Device Instance.

Refer to the index page for details.

For a quick setup, Please refer to the following images.

Figure 1.	 BACnet Network Addition

Figure 2.	 Change Touchscreen Room Controller Local Device Object ID

https://www.se.com/myschneider
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The TRC Device manager view is provided on the BACnet network.

The user can use the Discover button to find and add TRC devices on the Niagara database.

When the user discovers and adds TRC devices using this view, the correct Niagara-type device will be automatically selected.

Supported upload, download object, change value of TRC device object.

NOTE: The user should use TRC device manager to discover TRC devices from the BACnet network There are other device 
manager views available on the BACnet network. TRC devices discovered and added from other views will not work as expected.

Figure 3.	 Enable IP Port

https://www.se.com/myschneider
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Figure 4.	 Discover Touchscreen Room Controllers

Figure 5.	 Discovered controllers

https://www.se.com/myschneider
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Figure 6.	 Drag and Drop Touchscreen Room Controllers

https://www.se.com/myschneider
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Figure 7.	 TRC Device Object property sheet

TRC Device Object

Step 1.	 Configure and save its editable properties from the TRC Property sheet and invoke the "download object" action on 
TRC Device Object to download the object on the controller.

Step 1.	 Observe the download related error in the fault cause.

https://www.se.com/myschneider
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Chapter 2. Touchscreen Room Controllers and 
Configuration Objects

This topic describes the core workflows for bringing Touchscreen Room Controllers and their configuration objects to Niagara. 
It explains discovery, adding devices, synchronizing Niagara with controller data, and safely performing Upload, Download, 
Upload All, and Download All operations. These procedures form the essential day-to-day tasks for managing Touchscreen Room 
Controller installations.

Discover and add Controller to Niagara
Discover the Touchscreen Room Controllers from the Network and add them to Niagara. When Touchscreen Room Controllers 
are added to the Niagara database from the Device Manager view, they get the special functionalities specifically designed for 
Touchscreen Room Controllers.

Steps to discover and add Touchscreen Room Controllers to the N4 database:

Step 1.	 Connect to the station by double-clicking the station name in the application director. 

Step 2.	 The Touchscreen Room Controller Device manager view is provided on the BACnet network. Select the TRC Device 
Manager view from the Nav tree.

Step 3.	 Discover the controllers by clicking the Discover button.

Step 4.	 Update the device low limit, device high limit, networks in the Configure Device Discovery pop-up window.

Step 5.	 Once the discovery job completes, observe the online controllers list in the Discover pane.

Step 6.	 Select required controller, right-click and select the Add option.

Step 7.	 Click OK button on the Add pop-up window. Before clicking the OK button, change the Name, type, device ID, network, 
MAC address and enable, if required.

https://www.se.com/myschneider
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Step 9.	 Once the controller is added to the database pane, the following view becomes visible. 

Step 10.	Commands like Send LUA Program and Upload Standby Image will be enabled when user selects the controller from 
database pane. 

Step 11.	 User can not perform commands like Send LUA Program and Upload Standby Image on the devices from discovery 
pane. 

Step 12.	 When user selects multiple controllers from database pane and clicks on commands like Send LUA Program and Upload 
Standby Image, these commands will be invoked on all the controllers.

Step 8.	 Controller will appear in Niagara database pane.

https://www.se.com/myschneider
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Step 2.	 A pop-up window will open, where user can select the image file. Make sure the image files are saved in the shared folder 
of the station.

Upload Standby Image on Controllers

Step 1.	 In the TRC Device Manager view, select controllers from the Niagara database and click the Upload Standby Image 
command to start the process.

Step 3.	 Once the uploading of image is complete, it will show the status on Workbench’s bottom-right corner. Click on the job 
log icon, to see the status of each controller (success or failed).

Step 4.	 When uploading a standby image to a device, do not reselect the same device until the current job is fully completed. 
During this time, user can proceed to select and upload the standby image to a different controller.

https://www.se.com/myschneider
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Step 2.	 A filed editor will open, where user can write the Lua program. Click on Ok to send the program.

Lua Program on Multiple Controllers
Step 1.	 In the TRC Device Manager view, select controllers from the Niagara database and click on the "Send Lua Program." 

command button to start the process.

Step 3.	 Once program will be sent to all selected controllers, it will show the status on Workbench’s bottom-right corner. Click 
on the job log icon, to see the status of each controller (success or failed).

https://www.se.com/myschneider
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Step 2.	 A pop-up window will open, where the user can select the firmware file. Make sure the firmware files are saved in the 
shared folder of the station.

Firmware Upgrade on Multiple Controllers

Step 1.	 In the TRC Device Manager view, select controllers from the Niagara database and click Upgrade Firmware command to 
start the process.

Step 3.	 To activate the firmware immediately, the user should select Immediate. For activation at a later time, choose Scheduled 
and specify the desired time.

Step 4.	 Once the “Upgrade Firmware” job is complete, it will show the status on Workbench’s bottomright corner. Click on the 
job log icon, to see the status of each device (success or failed).

Step 5.	 When upgrading a firmware on a device, do not reselect the same device until the current job is fully completed. During 
this time, user can proceed to upgrade the firmware on a different controller.

https://www.se.com/myschneider
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Step 3.	 Select the desired objects and drag-drop the required objects from the Discover pane to the database pane.

Step 4.	 Select the required object. Click Ok to add it to Database pane. When objects are added from the controller to the 
Niagara database, they are uploaded and all their properties are read.

Discover and add Config objects

Once the controller is added to Niagara, discover the existing objects from the controller and add them to the Niagara database. 
When TRC Config objects are added to the Niagara database from TRC config Manager view, they get the special functionalities 
specifically designed for TRC objects.

Steps to discover objects:

Step 1.	 Navigate to TRC device > Config and double-click on Config container to open the TRC Config Manager view.

Step 2.	 Click the  Discover button to see all objects from the controller in discover pane.

https://www.se.com/myschneider
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Commands

Touchscreen Room Controller Copy and Paste
NOTE: In the Touchscreen Room Controller, only copy-paste functionality is customized. Cut-paste will continue to work as per 
Niagara's default behavior.

Below are the details related to the copy-paste functionality:

Step 1.	 Users can perform copy-paste operations using two main methods:

a.	 Right-click Copy-Paste: 
Right-click the object/folder → Select Copy  
Navigate to the destination → Right-click → Select Paste

b.	 Drag and Drop:  
Drag the object/folder and drop it in the desired view

Step 2.	 YES/NO Dialog to download the copied and pasted objects. 
For all copy-paste and some drag-and-drop actions, a YES/NO popup will be displayed:

a.	 YES: 
The pasted object is downloaded using a job if the device is online. 
 
NOTE: If pasted object/s does not exist in the target device,it will still be added to the Niagara database, but it will 
skip its download, and job will fail by giving error message in job log. If the device is offline, it will skip the download, 
and objects are only added to the database.

b.	 NO: 
The download is skipped, and the object stays in the database (whether the device is online or offline)

https://www.se.com/myschneider
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b.	 Preventing copy-paste between different devices if an object with the same ID already exists. This UI message will 
be generic; it won’t specify which IDs are duplicates. If the user is pasting an entire folder containing even one object 
that is already present in the target device, the entire copy-paste will fail.

Step 3.	 Extra Validations 
For online/offline devices, a user pop-up will add extra validations for:

a.	 Preventing copy-paste within the same device.

c.	 Drag-Drop Actions: For drag-and-drop actions like NAV Tree to NAV Tree or BOG/Palette to NAV Tree (when the 
destination is NAV Tree), the YES/NO Dialog popup will not be shown but the object will be added without triggering 
a download.

Step 4.	 Effect of Copy-Paste on Upload All / Download All Objects Job

a.	 Upload All Objects Job: This job will fail if there are unknown objects or a profile mismatch objects in niagara 
database device. [This could happen due to incorrect copy pasting of objects from one device to other.] Example 
of profile mismatch: if an Analog Output with profile 10-TRC-AnalogOutput (ID 21) already exists on the controller 
and the niagara database device already have object with profile 10-TRC-AnalogHardwareOutput (ID 21), the job will 
fail and the correct object with same object identifier will not be added to the niagara database. In such cases, the 
user should check the job log to identify failed objects, manually delete the incorrect object from Niagara database 
device, and then either perform config discovery add the correct object or user can again perform upload all.

https://www.se.com/myschneider
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Step 2.	 Change the “Should poll” to true state, Save it or right-click on object and click enable polling.

Step 3.	 All properties will show live values of points/objects from connected controller.

Step 4.	 For non-continuous (one time) update, right-click on object name select action as “Upload Object”.

Step 5.	 Once the values are uploaded, press refresh button on TRC Property sheet to update the min max and other facets.

Download Object

When the properties of objects in the controllers are configured or changed, it is necessary to download these updated objects 
to the controller.

Steps to download the object:

Step 1.	 Open the TRC property sheet of object by right-clicking on object > View > TRC property sheet.

Step 2.	 Change the values of the properties you want to modify, then right-click on the object and select Download Object. 

Step 3.	 It will download all the writable properties to the device. If device response with segmentation not supported message, 
then it divides the request recursively into half until we receive the successful response. 

b.	 Download All Objects Job: This job will fail if there are unknown objects or a profile mismatch objects in niagara 
database device. [This could happen due to incorrect copy pasting of objects from one device to other.] Example of 
profile mismatch: if an Analog Output with profile 10-TRC-AnalogOutput (ID 21) already exists on the controller and 
the niagara database device already have object with profile 10-TRC-AnalogHardwareOutput (ID 21) , the job will fail 
and the incorrect object with same object identifier will stay in the niagara database. In such cases, the user should 
check the job log to identify failed objects, manually delete the incorrect object from Niagara database device, and 
then perform download all objects job.

Upload Config Objects

Upload the config object’s properties from the Touchscreen Room Controller to Niagara.

Steps to upload the object:

Step 1.	 Open the TRC property sheet of object by right-clicking on object > View > TRC property sheet.

https://www.se.com/myschneider
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Step 4.	 Once the downloading of all object is complete, it will show the status on Workbench’s bottom-right corner. Click on the 
job log icon, to see the status of each object (success or failed). 

Step 5.	 For more information on error, look at the application director logs.

Upload All Objects

Upload all object action helps user to upload all the objects from the controller to the Niagara database at one time.

Steps to upload all objects:

Step 1.	 Right-click on the controller and from "action" menu, select the option Upload All. 

Step 2.	 Double-click on "Config" container of controller to see all objects uploaded from the controller to the Niagara database. 

Step 3.	 It discovers all objects from the controller and adds them to the Niagara database. If an object already exists, it will only 
be uploaded again.

Download All Config Objects

When the objects in the controllers are configured, it is required to download these objects to controller. Use the Download All 
functionality to download the objects from Niagara database to controller.

Steps to download all objects:

Step 1.	 Change the values of the properties you wish to modify for the objects present in the Niagara database. 

Step 2.	 Right-click on controller and from "action" menu, select the option Download All. 

Step 3.	 It will download all the writable properties to the device. If device response with segmentation not supported message, 
then it divides the request recursively into half until we receive the successful response. 

Step 4.	 Once the downloading of all objects is complete, it will show the status on Workbench's bottom-right corner. Click on the 
job log icon, to see the status of each object (success or failed). 

Step 5.	 For more information on error, look at the application director logs.

Modify Object’s Configuration

To change the value of the object’s property, open the TRC Property sheet and edit the values.

For more information, refer to the properties of individual components.

Please note that to view correct ordering of properties use the TRC Property Sheet instead of AX Property Sheet.

https://www.se.com/myschneider
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Chapter 3. Touchscreen Room Controller 
Hardware Reference

This topic provides a reference overview of the Touchscreen Room Controller hardware families, including TRC3500 and 
TRC6500 series devices and their W, X, and VC variants. Property sheets for each controller type describe key fields, behaviors, 
and available actions. Use this topic to understand device differences and confirm configuration expectations for specific 
models.

SXW-TRC-3500-Bcc-W

Touchscreen Room Controllers are a representation of actual controllers in the field.

If the controllers are connected, discover and add them under BACnet Network.

If the controllers are not connected and drag-n-drop the controller from palette to BACnet Network.

Figure 8.	 SXW-TRC-3500-Bcc-W property sheet

https://www.se.com/myschneider
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Property Value Description 

Status read-only Indicates the condition of the component at the last check. {ok} indicates that the 
component is licensed and polling successfully. 

{down} indicates that the last check was unsuccessful, perhaps because of an incorrect 
property, or possibly loss of network connection. 

{disabled} indicates that the Enable property is set to false. 

{fault} indicates another problem. Refer to Fault Cause for more information. 

Enabled true or false Activates and deactivates use of the component. 

Fault Cause read-only Indicates the reason why a system object (network, device, component, extension, etc.) is in 
fault. This property is empty unless a fault exists. 

Health read-only Indicates the status of a system object (network, device or component) in the station. 
Includes a timestamp. 

Alarm Source Info additional properties Contains a set of properties for configuring and routing alarms when this component is the 
alarm source. Refer to the Niagara Alarms Guide. 

Address additional properties Refer to Address.

Points additional properties Container for proxy points. Refer to the "Points" topic in this document. 

Virtual additional properties Provides access to virtual components in the station's virtual component space, specific to 
the device. This is in addition to the standard collection of slots for device-level components. 

Alarms additional properties Refer to Alarms.

Schedule ø (default) This component is the container for BACnet schedules under a BACnetDevice. Its default 
view is the BACnet Schedule Import Manager. Another view is the BACnet Schedule Export 
Manager, which enables writing schedules to a BACnet device. 

For more information refer to BACnet Schedule. 

Trend Logs additional properties Imports BACnet Trend Log objects from the device to the station as histories. 

Config additional properties Schedule components local to the station can reside anywhere under the station's Config 
hierarchy and be imported by one or more other stations. Refer to the "Config, Device Object" 
in this document. 

Enumeration List additional properties Lists the BACnet properties that can be exported to configure data exchange. The list 
provides access to each property's configuration facets. 

Cov Subscription read-only Reports number of active COV client subscriptions to the device. 

Character Set drop-down list  
(defaults to Ansi C3_4) 

Defines the character set supported, with other selections that is IBM/ Microsoft DBCS, JIS C 
6226, ISO 

10646 (UCS-4), ISO 10646 (UCS-2), 

ISO 8859-1, and "Unknown." 

Actions

•	 Upload all Object: Upload all the objects from Touchscreen Room Controller to Niagara.Then, it will discover all the objects 
from the controller and add the discovered objects into the Niagara database. If the discovered objects are already present 
in the Niagara database, they will only be uploaded.

•	 Download all Object: Download all the objects from the Niagara to Touchscreen Room Controller. During the ‘Download All’, 
it will download all writable properties of the objects present in the Niagara database to the controller.

•	 Upgrade Firmware: This action upgrades the controller’s firmware. Right-click on the device and select the ‘Upgrade 
Firmware’ action to initiate the firmware upgrade for the controller. This will open a window where user can choose a 
firmware file as an ord and select the activation type, which can be either immediate or scheduled, depending on user’s 
preference. 
 
After making the selection, the ‘Upgrade Firmware’ job will begin. Once the upgrade is complete, the status will be displayed 
in the bottom-right corner of the Workbench. Click on the job log icon to view thestatus details

https://www.se.com/myschneider
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SXW-TRC-3500-Bcc-X

Touchscreen Room Controllers are representation of actual controllers in the field.

If the controllers are connected, discover and add them under BACnet Network.

If the controllers are not connected and drag-n-drop the controller from palette to BACnet Network.

Figure 9.	 SXW-TRC-3500-Bcc-X property sheet

Property Value Description 

Status read-only Indicates the condition of the component at the last check. 

{ok} indicates that the component is licensed and polling successfully. 

{down} indicates that the last check was unsuccessful, perhaps because of an incorrect 
property, or possibly loss of network connection. 

{disabled} indicates that the Enable property is set to false. 

{fault} indicates another problem. Refer to Fault Cause for more information. 

Enabled true or false Activates and deactivates use of the component. 

Fault Cause read-only Indicates the reason why a system object (network, device, component, extension, etc.) is 
in fault. This property is empty unless a fault exists. 

Health read-only Indicates the status of a system object (network, device or component) in the station. 
Includes a timestamp. 

Alarm Source Info additional properties Contains a set of properties for configuring and routing alarms when this component is 
the alarm source. Refer to the Niagara Alarms Guide. 
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Property Value Description 

Address additional properties Refer to Address [Niagara documentationion]. 

Points additional properties Container for proxy points. Refer to the "Points" topic in this document. 

Virtual additional properties Provides access to virtual components in the station's virtual component space, specific 
to the device. This is in addition to the standard collection of slots for device-level 
components. 

Alarms additional properties Refer to Alarms [Niagara documentationion]. 

Schedule ø (default) This component is the container for BACnet schedules under a BACnetDevice. Its 
default view is the BACnet Schedule Import Manager. Another view is the BACnet 
Schedule Export Manager, which enables writing schedules to a BACnet device. For more 
information refer to BACnet Schedule [Niagara documentationion]. 

Trend Logs additional properties Imports BACnet Trend Log objects from the device to the station as histories. 

Config additional properties Schedule components local to the station can reside anywhere under the station's Config 
hierarchy and be imported by one or more other stations. Refer to the "Config, Device 
Object" in this document. 

Enumeration List additional properties Lists the BACnet properties that can be exported to configure data exchange. The list 
provides access to each property's configuration facets. 

Cov Subscription read-only Reports number of active COV client subscriptions to the device. 

Character Set drop-down list (defaults to 
Ansi C3_4) 

Defines the character set supported, with other selections that is IBM/ Microsoft DBCS, 
JIS C 6226, ISO 

10646 (UCS-4), ISO 10646 (UCS-2), 

ISO 8859-1, and "Unknown." 

Actions

•	 Upload all Object: Upload all the objects from Touchscreen Room Controller to Niagara.Then, it will discover all the objects 
from the controller and add the discovered objects into the Niagara database. If the discovered objects are already present 
in the Niagara database, they will only be uploaded.

•	 Download all Object: Download all the objects from the Niagara to Touchscreen Room Controller. During the ‘Download All’, 
it will download all writable properties of the objects present in the Niagara database to the controller.

•	 Upgrade Firmware: This action upgrades the controller’s firmware. Right-click on the device and select the ‘Upgrade 
Firmware’ action to initiate the firmware upgrade for the controller. This will open a window where user can choose a 
firmware file as an ord and select the activation type, which can be either immediate or scheduled, depending on user’s 
preference. 
 
After making the selection, the ‘Upgrade Firmware’ job will begin. Once the upgrade is complete, the status will be displayed 
in the bottom-right corner of the Workbench. Click on the job log icon to view the status details.
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SXW-TRC-6500-Bcc-W

Touchscreen Room Controller are representation of actual controllers in the field.

If the controllers are connected, discover and add them under BACnet Network.

If the controllers are not connected and drag-n-drop the controller from palette to BACnet Network.

Figure 10.	 SXW-TRC-6500-Bcc-W property sheet

Property Value Description 

Status read-only Indicates the condition of the component at the last check. 

{ok} indicates that the component is licensed and polling successfully. 

{down} indicates that the last check was unsuccessful, perhaps because of an incorrect 
property, or possibly loss of network connection. 

{disabled} indicates that the Enable property is set to false. 

{fault} indicates another problem. Refer to Fault Cause for more information. 

Enabled true or false Activates and deactivates use of the component. 

Fault Cause read-only Indicates the reason why a system object (network, device, component, extension, etc.) is in 
fault. This property is empty unless a fault exists. 

Health read-only Indicates the status of a system object (network, device or component) in the station. Includes 
a timestamp. 
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Property Value Description 

Alarm Source Info additional properties Contains a set of properties for configuring and routing alarms when this component is the 
alarm source. Refer to the Niagara Alarms Guide. 

Address additional properties Refer Address [Niagara documentationion]. 

Points additional properties Container for proxy points. Refer to the "Points" topic in this document. 

Virtual additional properties Provides access to virtual components in the station's virtual component space, specific to 
the device. This is in addition to the standard collection of slots for device-level components. 

Alarms additional properties Refer to Alarms [Niagara documentationion]. 

Schedule ø (default) This component is the container for BACnet schedules under a BACnetDevice. Its default 
view is the BACnet Schedule Import Manager. Another view is the BACnet Schedule Export 
Manager, which enables writing schedules to a BACnet device. 

For more information refer to BACnet Schedule [Niagara documentationion]. 

Trend Logs additional properties Imports BACnet Trend Log objects from the device to the station as histories. 

Config additional properties Schedule components local to the station can reside anywhere under the station's Config 
hierarchy and be imported by one or more other stations. Refer to the "Config, Device Object" 
in this document. 

Enumeration List additional properties Lists the BACnet properties that can be exported to configure data exchange. The list 
provides access to each property's configuration facets. 

Cov Subscription read-only Reports number of active COV client subscriptions to the device. 

Character Set drop-down list 
(defaults to Ansi C3_4) 

Defines the character set supported, with other selections that is IBM/ Microsoft DBCS, JIS C 
6226, ISO 

10646 (UCS-4), ISO 10646 (UCS-2), 

ISO 8859-1, and "Unknown." 

Actions

•	 Upload all Object: Upload all the objects from Touchscreen Room Controller to Niagara.Then, it will discover all the objects 
from the controller and add the discovered objects into the Niagara database. If the discovered objects are already present 
in the Niagara database, they will only be uploaded.

•	 Download all Object: Download all the objects from the Niagara to Touchscreen Room Controller. During the ‘Download All’, 
it will download all writable properties of the objects present in the Niagara database to the controller.

•	 Upgrade Firmware: This action upgrades the controller’s firmware. Right-click on the device and select the ‘Upgrade 
Firmware’ action to initiate the firmware upgrade for the controller. This will open a window where user can choose a 
firmware file as an ord and select the activation type, which can be either immediate or scheduled, depending on user’s 
preference.  
 
After making the selection, the ‘Upgrade Firmware’ job will begin. Once the upgrade is complete, the status will be displayed 
in the bottom-right corner of the Workbench. Click on the job log icon to view the status details
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SXW-TRC-6500-Bcc-X

Touchscreen Room Controller are representation of actual controllers in the field.

If the controllers are connected, discover and add them under BACnet Network.

If the controllers are not connected and drag-n-drop the controller from palette to BACnet Network.

Figure 11.	 SXW-TRC-6500-Bcc-X property sheet

Property Value Description 

Status read-only Indicates the condition of the component at the last check. 

{ok} indicates that the component is licensed and polling successfully. 

{down} indicates that the last check was unsuccessful, perhaps because of an incorrect 
property, or possibly loss of network connection. 

{disabled} indicates that the Enable property is set to false. 

{fault} indicates another problem. Refer to Fault Cause for more information. 

Enabled true or false Activates and deactivates use of the component. 

Fault Cause read-only Indicates the reason why a system object (network, device, component, extension, etc.) is in 
fault. This property is empty unless a fault exists. 

Health read-only Indicates the status of a system object (network, device or component) in the station. 
Includes a timestamp. 

Alarm Source Info additional properties Contains a set of properties for configuring and routing alarms when this component is the 
alarm source. Refer to the Niagara Alarms Guide. 
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Property Value Description 

Address additional properties Refer to Address [Niagara documentationion]. 

Points additional properties Container for proxy points. Refer to the "Points" topic in this document. 

Virtual additional properties Provides access to virtual components in the station's virtual component space, specific to 
the device. This is in addition to the standard collection of slots for device-level components. 

Alarms additional properties Refer to Alarms [Niagara documentationion]. 

Schedule ø (default) This component is the container for BACnet schedules under a BACnetDevice. Its default 
view is the BACnet Schedule Import Manager. Another view is the BACnet Schedule Export 
Manager, which enables writing schedules to a BACnet device. 

For more information refer to BACnet Schedule [Niagara documentationion]. 

Trend Logs additional properties Imports BACnet Trend Log objects from the device to the station as histories. 

Config additional properties Schedule components local to the station can reside anywhere under the station's Config 
hierarchy and be imported by one or more other stations. Refer to the "Config, Device Object" 
in this document. 

Enumeration List additional properties Lists the BACnet properties that can be exported to configure data exchange. The list 
provides access to each property's configuration facets. 

Cov Subscription read-only Reports number of active COV client subscriptions to the device. 

Character Set drop-down list 
(defaults to Ansi 

C3_4) 

Defines the character set supported, with other selections that is IBM/ Microsoft DBCS, JIS C 
6226, ISO 

10646 (UCS-4), ISO 10646 (UCS-2), 

ISO 8859-1, and "Unknown." 

Actions

•	 Upload all Object: Upload all the objects from Touchscreen Room Controller to Niagara.Then, it will discover all the objects 
from the controller and add the discovered objects into the Niagara database. If the discovered objects are already present 
in the Niagara database, they will only be uploaded.

•	 Download all Object: Download all the objects from the Niagara to Touchscreen Room Controller. During the ‘Download All’, 
it will download all writable properties of the objects present in the Niagara database to the controller.

•	 Upgrade Firmware: This action upgrades the controller’s firmware. Right-click on the device and select the ‘Upgrade 
Firmware’ action to initiate the firmware upgrade for the controller. This will open a window where user can choose a 
firmware file as an ord and select the activation type, which can be either immediate or scheduled, depending on user’s 
preference.  
 
After making the selection, the ‘Upgrade Firmware’ job will begin. Once the upgrade is complete, the status will be displayed 
in the bottom-right corner of the Workbench. Click on the job log icon to view the status details.
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Chapter 4. Analog Objects

This topic explains the analog object types supported by Touchscreen Room Controllers, including inputs, outputs, hardware 
outputs, values, hardware values, and Lua-based analog values. Each object description covers how the object behaves, what 
its properties mean, and how it is configured in Niagara. Use this topic when working with any analog sensor, command, or 
calculated value in a Touchscreen Room Controller system.

Analog Input

Step 1.	 Drop this object from device on to the Touchscreen Room Controller’s config space, object gets uploaded as soon as it 
is dragged on config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object in the controller.

Step 3.	 Observe the download related error in the fault cause.

Analog Input Property Sheet

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when 
polling is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required.

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Figure 12.	 Analog Input property sheet
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Property Value Description 

Object Id Object Identifier Read Only Uniquely identifies the object in controller. This is set in following 
scenario: 

When existing object is uploaded from the controller.(using device.
uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Analog Input Read Only Type of the object. 

Profile Name 10-TRC-AnalogInput Read Only Name of the profile. Properties of the object varies based on profile of 
that object. 

Present Value Float Editable Present value of the object. For input points, when the present value is 
changed and downloaded to controller, its out-of-service property is set 
to true. 

Units Depends on the object Read Only Unit for this object. 

Status Flags range[Alarm, Fault, overridden, Out-of-Service] 
Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Reliability range[refer BBACnetReliability enum]Read Only Shows the current value of reliability. 

Event State range[Normal, Fault, Off-normal, High-limit, Low-
limit, Life-Safety Alarm]Read Only 

State of the event enrollment. 

Cov Increment Float Editable Change of Value Increment. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Analog Output Property Sheet
Figure 13.	 Analog Output property sheet

Analog Output

Step 1.	 Drop this object from device on to the Touchscreen Room Controller’s config space, object gets uploaded as soon as it 
is dragged on config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.

https://www.se.com/myschneider


34SpaceLogic™ Touchscreen Room Controller  [ Technical Document ]

998-25275950-1_EN	 www.se.com	 April 2026

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when polling 
is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required.

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following scenario: 

When existing object is uploaded from the controller.(using device.
uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Analog Output Read Only Type of the object. 

Profile Name 10-TRC-AnalogOutput Read Only Name of the profile. Properties of the object varies based on profile of 
that object. 

Present Value Float Editable Present value of the object. For input points, when the present value is 
changed and downloaded to controller, its out-of-service property is set 
to true. 

Units Depends on the object Read Only Unit for this object. 

Priority Array array Editable Priorities 1-16 

Relinquish Default Float Read Only 

Cov Increment Float Editable Change of Value Increment. 

Status Flags range[Alarm, Fault, overridden, 
Out-of-Service] Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Reliability range[refer BBACnetReliability 
enum] Read Only 

Shows the current value of reliability. 

Event State range[Normal, Fault, Off-normal, 
High-limit, Low-limit, Life-Safety 
Alarm] Read Only 

State of the event enrollment. 

High Limit (Alarm) Float Editable Alarm High Limit. 

Low Limit (Alarm) Float Editable Alarm Low Limit. 

Current Command Priority Analog Output Read Only. Shows the current command priority. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Figure 14.	 Analog Hardware Output property sheet

Analog Hardware Output

Step 1.	 Drop this object from device on to the Touchscreen Room Controller's config space, object gets uploaded as soon as it 
is dragged on config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.

Analog Hardware Output Property Sheet
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when 
polling is enabled.(should Poll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller. This is set in following 
scenario: 

When existing object is uploaded from the controller.(using device.
upload All action) 

Object Name String Read Only Name of the object in controller. 

Object Type Analog Hardware Output Read Only Type of the object. 

Profile Name 10-TRC-AnalogHardwareOutput Read 
Only 

Name of the profile. Properties of the object varies based on profile of 
that object. 

Present Value Float Editable Present value of the object. For input points, when the present value 
is changed and downloaded to controller, its out-of-service property 
is set to true. 

Units Depends on the object Read Only Unit for this object. 

Priority Array array Editable Priorities 1-16 

Relinquish Default Float Read Only 

Cov Increment Float Editable Change of Value Increment. 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Reliability range[refer BBACnetReliability enum] 
Read Only 

Shows the current value of reliability. 

Event State range[Normal, Fault, Off-normal, High-
limit, Low-limit, Life-Safety Alarm] Read 
Only 

State of the event enrollment. 

Current Command Priority Analog Output Read Only. Shows the current command priority. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Analog Value

Step 1.	 Drop this object from device on to the Touchscreen Room Controller's config space,object gets uploaded as soon as it is 
dragged on config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.

Analog Value Property Sheet
Figure 15.	 Analog Value property sheet
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only 
when polling is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following 
scenario: 

When existing object is uploaded from the controller.(using 
device.uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Analog Value Read Only Type of the object. 

Profile Name 10-TRC-AnalogValue Read Only Name of the profile. Properties of the object varies based on 
profile of that object. 

Present Value Float Editable Present value of the object. For input points, when the present 
value is changed and downloaded to controller, its out-of-service 
property is set to true. 

Units Depends on the object Read Only Unit for this object. 

Priority Array array Editable Priorities 1-16 

Relinquish Default Float Editable 

Cov Increment Float Editable Change of Value Increment. 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Reliability range[refer BBACnetReliability enum] Read 
Only 

Shows the current value of reliability. 

Event State range[Normal, Fault, Off-normal, High-limit, 
Low-limit, Life-Safety Alarm] Read Only 

State of the event enrollment. 

Current Command Priority Analog Output Read Only. Shows the current command priority. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Analog Hardware Value Property Sheet
Figure 16.	 Analog Hardware Value property sheet

Analog Hardware Value

Step 1.	 Drop this object from device on to the Touchscreen Room Controller's config space,object gets uploaded as soon as it is 
dragged on config space. 

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object to the controller. 

Step 3.	 Observe the download related error in the fault cause.
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when 
polling is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller. This is set in following 
scenario: 

When existing object is uploaded from the controller.(using 
device.uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Analog Hardware Value Read Only Type of the object. 

Profile Name 10-TRC-AnalogHardwareValue Read Only Name of the profile. Properties of the object varies based on 
profile of that object. 

Present Value Float Editable Present value of the object. For input points, when the present 
value is changed and downloaded to controller, its out-of-service 
property is set to true. 

Units Depends on the object Read Only Unit for this object. 

Priority Array Array Editable Priorities 1-16 

Relinquish Default Float Read Only 

Cov Increment Float Editable Change of Value Increment. 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Reliability range[refer BBACnetReliability enum] 
Read Only 

Shows the current value of reliability. 

Event State range[Normal, Fault, Off-normal, High-limit, 
Low-limit, Life-Safety Alarm] Read Only 

State of the event enrollment. 

High Limit (Alarm) Float Editable Alarm High Limit. 

Low Limit (Alarm) Float Editable Alarm Low Limit. 

Current Command Priority Analog Output Read Only. Shows the current command priority. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Figure 17.	 Analog Lua Value property sheet

Analog Lua Value property sheet

Analog Lua Value

Step 1.	 Drop this object from device on to the Touchscreen Room Controller’s config space,object gets uploaded as soon as it is 
dragged on config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only 
when polling is enabled.(shouldPoll is true)

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following 
scenario: 

When existing object is uploaded from the controller.(using 
device.uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Analog Lua Value Read Only Type of the object. 

Profile Name 10-TRC-AnalogLuaValue Read Only Name of the profile. Properties of the object varies based on 
profile of that object. 

Present Value Float Editable Present value of the object. For input points, when the present 
value is changed and downloaded to controller, its out-of-service 
property is set to true. 

Units Depends ob the object Read Only Unit for this object. 

Priority Array array Editable Priorities 1-16 

Relinquish Default Float Editable 

Cov Increment Float Editable Change of Value Increment. 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Reliability range[refer BBACnetReliability enum] 
Read Only 

Shows the current value of reliability. 

Event State range[Normal, Fault, Off-normal, High-limit, 
Low-limit, Life-Safety Alarm] Read Only 

State of the event enrollment. 

High Limit (Alarm) Float Editable Alarm High Limit. 

Low Limit (Alarm) Float Editable Alarm Low Limit. 

Current Command Priority Analog Output Read Only. Shows the current command priority. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Chapter 5. Binary, Multistate, and String Objects

This topic groups all TRC boolean, state-driven, and text-based objects, including Binary Input, Binary Output, Binary Value, 
Multistate Input, Multistate Value, and String Value. Detailed property sheets help explain how each object represents device 
conditions, commands, or enumerated states. Use this topic as a reference when configuring common digital points or state-
based logic.

Binary Input

Step 1.	 Drop this object from device on to the Touchscreen Room Controller's config space,object gets uploaded as soon as it is 
dragged on config space. 

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object to the controller. 

Step 3.	 Observe the download related error in the fault cause.

Binary Input Property Sheet
Figure 18.	 Binary Input property sheet
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when polling is 
enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following scenario: 

When existing object is uploaded from the controller.(using device.uploadAll 
action) 

Object Name String Read Only Name of the object in controller. 

Object Type Binary Input Read Only Type of the object. 

Profile Name 10-TRC-BinaryInput Read Only Name of the profile. Properties of the object varies based on profile of that object. 

Present Value Float Editable Present value of the object. For input points, when the present value is changed 
and downloaded to controller, its out-of-service property is set to true. 

Inactive Text String Read Only Characterizes intended effect of the IN ACTIVE state of Present_Value property 

Active Text String Read Only Characterizes intended effect of the ACTIVE state of Present_Value property 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Event State range[Normal, Fault, Off-normal, High-
limit, Low-limit, Life-Safety Alarm] 
Read Only 

State of the event enrollment. 

Polarity range[Normal, Reverse] Read Only Shows the current value of reliability. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Binary Output Property Sheet
Figure 19.	 Binary Output property sheet

Binary Output

Step 1.	 Drop this object from device on to the Touchscreen Room Controller's config space,object gets uploaded as soon as it is 
dragged on config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only 
when polling is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following 
scenario: 

When existing object is uploaded from the controller.(using 
device.uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Binary Output Read Only Type of the object. 

Profile Name 10-TRC-BinaryOutput Read Only Name of the profile. Properties of the object varies based on 
profile of that object. 

Present Value Float Editable Present value of the object. For Input points, when the present 
value is changed and downloaded to controller, its out-of-service 
property is set to true. 

Priority Array array Editable Priorities 1-16 

Relinquish Default Float Read Only 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Event State range[Normal, Fault, Off-normal, High-limit, 
Low-limit, Life-Safety Alarm] Read Only 

State of the event enrollment. 

Polarity range[Normal, Reverse] Read Only Shows the current value of reliability. 

Inactive Text String Read Only 

Active Text String Read Only 

Current Command Priority Binary Output Read Only. Shows the current command priority. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Binary Value

Step 1.	 Drop this object from device on to the Touchscreen Room Controller's config space,object gets uploaded as soon as it is 
dragged on config space. 

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object to the controller. 

Step 3.	 Observe the download related error in the fault cause.

Binary Value Property Sheet
Figure 20.	 Binary Value property sheet
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only 
when polling is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in 
following scenario: 

• When existing object is uploaded from the controller.(using 
device.uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Binary Value Read Only Type of the object. 

Profile Name 10-TRC-BinaryValue Read Only Name of the profile. Properties of the object varies based on 
profile of that object. 

Present Value Float Editable Present value of the object. For Input points, when the 
present value is changed and downloaded to controller, its 
out-of-service property is set to true. 

Priority Array array Editable Priorities 1-16 

Inactive Text String Read Only Shows the current value of Inactive Text. 

Relinquish Default Float Editable 

Active Text String Read Only Shows the current value of Active Text. 

Status Flags range[Alarm, Fault, overridden, Out-of-Service] 
Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Event State range[Normal, Fault, Off-normal, High-limit, 
Low-limit, Life-Safety Alarm] Read Only 

State of the event enrollment. 

Current Command Priority Binary Value Read Only. Shows the current command priority. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Multistate Input

Step 1.	 Drop this object from device on to the TRC Controller’s config space,object gets uploaded as soon as it is dragged on 
config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the TRC 
Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.

Multistate Input Property Sheet

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when polling 
is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Figure 21.	 Multistate Input property sheet
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Property Value Description 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following scenario: 

When existing object is uploaded from the controller.(using device.
uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Multistate Input Read Only Type of the object. 

Profile Name 10-TRC-MultistateInput Read Only Name of the profile. Properties of the object varies based on profile of 
that object. 

Value Multistate Value Editable. Present value of the object. For input points, when the present value is 
changed and downloaded to controller, its out-of-service property is set 
to true. 

State Text Multistate Value Read-only. 

Number Of States Multistate Value Read-only. Unit for this object. 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Event State range[Normal, Fault, Off-normal, High-limit, 
Low-limit, Life-Safety Alarm] Read Only 

State of the event enrollment. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Multistate Value

Step 1.	 Drop this object from device on to the TRC Controller’s config space,object gets uploaded as soon as it is dragged on 
config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the TRC 
Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.

Multistate Value Property Sheet

Figure 22.	 Multistate Value property sheet
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is 
effective only when polling is enabled.(shouldPoll is 
true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is 
effective only when polling is enabled.(shouldPoll is 
true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set 
in following scenario: 

When existing object is uploaded from the 
controller.(using device.uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Multistate Value Read Only Type of the object. 

Profile Name 10-TRC-MultistateValue Read Only Name of the profile. Properties of the object varies 
based on profile of that object. 

Value Multistate Value Editable. Present value of the object. For input points, when 
the present value is changed and downloaded to 
controller, its out-of-service property is set to true. 

Priority Array array Editable Priorities 1-16 

State Text Multistate Value Read-only. 

Number Of States Multistate Value Read-only. Unit for this object. 

Relinquish Default Float Editable 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read Only 

Status of the object in controller. 

Out Of Service true/false Editable Marks the object as out of service. 

Event State range[Normal, Fault, Off-normal, High-limit, 
Low-limit, Life-Safety Alarm] Read Only 

State of the event enrollment. 

Current Command Priority Binary Value Read Only. Shows the current command priority. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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String Value Property Sheet

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when 
polling is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following 
scenario: 

• When existing object is uploaded from the controller.(using device.
uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Analog Input Read Only Type of the object. 

Figure 23.	 String Value property sheet

String Value

Step 1.	 Drop this object from palette on to the Touchscreen Room Controller's config space, object gets created as soon as it is 
dragged on config space. 

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke "Download All" action on 
Touchscreen Room Controller to create the object in controller and download the changes if controller was offline when 
object was dragged and dropped. 

Step 3.	 Once it is created in controller, Open the TRC Property sheet of the object, change the values and save it to download it 
to controller. 

Step 4.	 Observe the download related error in the fault cause.
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Property Value Description 

Profile Name 10-TRC-CharacterStringValue Read Only Name of the profile. Properties of the object varies based on profile 
of that object. 

Event State range[Normal, Fault, Off-normal, High-limit, Low-
limit, Life-Safety Alarm] Read Only 

State of the event enrollment. 

Present Value String Editable Changing the value on TRC property sheet and saving it, will cause 
download of value to device if device is online. 

Status Flags range[Alarm, Fault, overridden, Out-of-Service] 
Read Only 

Status of the object in controller. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Chapter 6. Schedules and Calendars

This topic covers TRC scheduling objects, including the Enumerated Schedule and Calendar. It explains how schedules and 
calendar events are defined, how they interact with controller logic, and how they can be imported or managed within Niagara. 
Use this topic to configure or troubleshoot time-based behavior within TRC systems.

Enumerated Schedule
Drop this object from TRC Controller's config space to TRC Config space,object gets uploaded as soon as it is dragged on config 
space. Once it is uploaded, Open the TRC Property sheet of the object, change the values and save it to download it to controller. 
Observe the download related error in the fault cause.

To configure the weekly schedule/exception schedules using Niagara's default schedule editor, use following steps:

Step 1.	 Create a Schedule in Niagara (from schedule module).

Step 2.	 Drag-n-drop the desired type of schedule from TRC Controller on TRC Config Space.

Step 3.	 Navigate to TRC Controller > Schedules > BACnet Schedule Export manager.

Step 4.	 Discover the schedules from the controller and add them in the database.

Step 5.	 While adding, choose the Niagara schedule (that needs to be exported) as a supervisor Ord and add type as 
Enumerated.

Step 6.	 Configure weekly schedule and exception schedule in Niagara Schedule.
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Enumerated Schedule Property Sheet

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when 
polling is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read-only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Figure 24.	 Enumerated Schedule property sheet
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Property Value Description 

Object Id Object Identifier Read-only. Uniquely identifies the object in controller.This is set in following 
scenario: 

When existing object is uploaded from the controller.(using device.
uploadAll action) 

Object Name String Read-only. Name of the object in controller. 

Object Type Schedule Read-only. Type of the object. 

Profile Name 10-TRC-Schedule Read-only. Name of the profile. Properties of the object varies based on profile of 
that object. 

Present Value Editable Present value of the schedule. 

Effective Period Read-only Period during which schedule is effective. 

Priority for Writing Editable 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read-only. 

Status of the object in controller. 

Reliability range[refer BBACnetReliability enum] Read 
Only 

Shows the current value of reliability. 

Out of Service true/false Editable. Marks the object as out of service. 

Schedule Default Read Only 

Weekly Schedule Editable Modify the weekly schedule. If you prefer to use the Niagara schedule 
editor UI then follow above steps. 

Exception Schedule Editable Modify the exception schedule. If you prefer to use the Niagara 
schedule editor UI then follow above steps. 

Actions

•	 Upload Object : Upload the object’s properties from the controller.

•	 Download Object : Download all its configured properties to the controller.

https://www.se.com/myschneider


58SpaceLogic™ Touchscreen Room Controller  [ Technical Document ]

998-25275950-1_EN	 www.se.com	 April 2026

Calendar

Drop this object from device on to the TRC Controller's config space,object gets uploaded as soon as it is dragged on config 
space. Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the TRC 
Controller to download the object to the controller. Observe the download related error in the fault cause.

To configure the weekly schedule/exception schedules using Niagara's default schedule editor, use following steps:

Step 1.	 Create a Schedule in Niagara (from schedule module). 

Step 2.	 Drag-n-drop the desired type of schedule from TRC device on TRC Controller->Config wiresheet. 

Step 3.	 Navigate to TRC Controller->Schedules->BACnet Schedule Export manager. 

Step 4.	 Discover the schedules from the controller and add them in the database. 

Step 5.	 While adding, choose the Niagara schedule (that needs to be exported) as a supervisor Ord. 

Step 6.	 Configure weekly schedule and exception schedule of Niagara Schedule by giving the calendar reference.
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Calendar Property Sheet

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when polling is enabled.
(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read-only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read-only. Uniquely identifies the object in controller.This is set in following scenario: 

When existing object is uploaded from the controller.(using device.uploadAll action) 

Object Name String Read-only. Name of the object in controller. 

Object Type Calendar Read-only. Type of the object. 

Profile Name 10-TRC-Calendar Read-only. Name of the profile. Properties of the object varies based on profile of that object. 

Present Value Read-only. Present value of the object. For input points, when the present value is changed and 
downloaded to controller, its out-of-service property is set to true. 

Datelist Editable List of dates for calendar. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.

Figure 25.	 Calendar property sheet

https://www.se.com/myschneider


60SpaceLogic™ Touchscreen Room Controller  [ Technical Document ]

998-25275950-1_EN	 www.se.com	 April 2026

Chapter 7. Lua Programs, Files, Logs, and 
Upgrades
This topic describes programmatic and file-based TRC objects, including Lua Programs, Lua Files, Log Files, Image Files, Upgrade 
Packages, and Network Port settings. It explains how these objects support scripting, diagnostics, file storage, firmware updates, 
and network communication. Use this topic when deploying Lua logic, managing controller files, collecting logs, or performing 
firmware and maintenance operations.

Lua Program

Step 1.	 Drop this object from device on to the TRC Controller's config space,object gets uploaded as soon as it is dragged on 
config space. 

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the TRC 
Controller to download the object to the controller. 

Step 3.	 Observe the download related error in the fault cause.

Lua Program Property Sheet
Figure 26.	 Lua Program property sheet
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when polling 
is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following scenario: 

• When existing object is uploaded from the controller.(using device.
uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Lua Program Read Only Type of the object. 

Profile Name 10-TRC-LuaProgram Read Only Name of the profile. Properties of the object varies based on profile of that 
object. 

Description String Read Only Description of the object. 

Program State range[Normal, Fault, Off-normal, High-
limit, Low-limit, Life-Safety Alarm] Read-
only. 

Current logical state of the PG objects executing application programs 

Program Change range[refer BBACnetProgramState enum] 
Editable 

Used to request changes to the operating state of the program. Writing to 
property affects all 10 PG objects 

Out Of Service true/false Read Only Marks the object as out of service. 

Description of Halt String Read-only. Describes the reason why a program has been halted. 

Instance Of String Read-only. Local name of the application program being executed by this process. 

Reason for Halt BBACnetProgramError Read-only. If program halts, this property reflects the reason for halt 
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TRC Script Editor

Step 1.	 To open the TRC script editor, navigate to the Lua program and select view as "TRC Script Editor."

Step 2.	 Below is the editor, on which the content will be shown from Niagara database.

Step 3.	 In the editor, you will find three buttons at the top: 
Read: This button allows you to read the program from the controller, which will then be displayed in the editor. 
Save: In this section of the editor, you can write a Lua program and save it to the Niagara database. 
Send: This button enables you to send the program which is written on the script editor to the controller.
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Step 4.	 Below the editor, there are four tabbed sections: 
File Status: This tab displays the current status, such as “Reading content from the controller/Sending file content to 
controller.” 
Program State: This pane will show the latest property value of “Program State” after reading the program and after 
sending the Lua program. 
Reason for Halt: This pane will show the latest property value of “Reason for Halt” after reading the program and after 
sending the Lua program. 
Description of Halt: This pane will show the latest property value of “Description of Halt” after reading the program and 
after sending the Lua program.

Actions

•	 Upload Object:Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Lua File Property Sheet

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] 
Editable 

Defines the polling frequency. This property is effective only when polling is 
enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following scenario: 

When existing object is uploaded from the controller.(using device.uploadAll 
action) 

Object Name String Read Only Name of the object in controller. 

Figure 27.	 Lua File property sheet

Lua File

Step 1.	 Drop this object from device on to the TRC Controller's config space,object gets uploaded as soon as it is dragged on 
config space. 

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the TRC 
Controller to download the object to the controller. 

Step 3.	 Observe the download related error in the fault cause. 

Step 4.	 Select the "TRC File Viewer" view to read the content from the device and view it.
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Property Value Description 

Object Type Lua File Read Only Type of the object. 

Profile Name 10-TRC-LuaFile Read Only Name of the profile. Properties of the object varies based on profile of that object. 

File Type Enumeration Read-only Shows the File Type of the object. 

File Size integer Read-only Shows the File Size of the object. 

Modification Date Read-only Shows the Modification Date of the object. 

Archive true/false Editable Shows the Archive property of the object. 

Read Only true/false Read-only Shows the Read Only property of the object. 

File Access Method Enumerable Read-only Shows the File Access Method of the object. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Log File

Step 1.	 Drop this object from device on to the TRC Controller's config space,object gets uploaded as soon as it is dragged on 
config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the TRC 
Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.

Step 4.	 Select the "TRC File Viewer" view to read the content from the device and view it.

Log File Property Sheet
Figure 28.	 Log File property sheet

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when polling is 
enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following scenario: 

When existing object is uploaded from the controller.(using device.uploadAll 
action) 
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Property Value Description 

Object Name String Read Only Name of the object in controller. 

Object Type Log File Read Only Type of the object. 

Profile Name 10-TRC-LogFile Read Only Name of the profile. Properties of the object varies based on profile of that 
object. 

File Type Enumeration Read-only Shows the File Type of the object. 

File Size integer Editable Shows the File Size of the object. 

Modification Date Read-only Shows the Modification Date of the object. 

Archive true/false Editable Shows the Archive property of the object. 

Read Only true/false Read-only Shows the Read Only property of the object. 

File Access Method Enumerable Read-only Shows the File Access Method of the object. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Image File

Step 1.	 Drop this object from device on to the Touchscreen Room Controller's config space,object gets uploaded as soon as it is 
dragged on config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the 
Touchscreen Room Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.

Image File Property Sheet

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] 
Editable 

Defines the polling frequency. This property is effective only when polling is enabled.
(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following scenario: 

When existing object is uploaded from the controller.(using device.uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Image File Read Only Type of the object. 

Figure 29.	 Image File property sheet

https://www.se.com/myschneider


69SpaceLogic™ Touchscreen Room Controller  [ Technical Document ]

998-25275950-1_EN	 www.se.com	 April 2026

Property Value Description 

Profile Name 10-TRC-ImageFile Read Only Name of the profile. Properties of the object varies based on profile of that object. 

File Type Enumeration Read-only Shows the File Type of the object. 

File Size integer Read-only Shows the File Size of the object. 

Modification Date Read-only Shows the Modification Date of the object. 

Archive true/false Editable Shows the Archive property of the object. 

Read Only true/false Read-only Shows the Read Only property of the object. 

File Access Method Enumerable Read-only Shows the File Access Method of the object. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.

•	 Send File: Right-click on the image file object and select the ‘Send File’ action to send the image to the controller. This will 
open a window where user can choose an image file as an ord, and the job ‘Send Image File’ will begin. Once the “image 
upload” is complete, it will show the status on Workbench’s bottom-right corner. Click on the job log icon, to see the status.
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Upgrade Package

Step 1.	 Drop this object from device on to the TRC Controller's config space,object gets uploaded as soon as it is dragged on 
config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the TRC 
Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause.

Upgrade Package Property Sheet

Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when 
polling is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Figure 30.	 Upgrade Package property sheet
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Property Value Description 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following 
scenario: 

• When existing object is uploaded from the controller.(using device.
uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Upgrade Package Read Only Type of the object. 

Profile Name 10-TRC-UpgradePackage Read Only Name of the profile. Properties of the object varies based on profile of 
that object. 

File Type Enumeration Read-only Shows the File Type of the object. 

File Size integer Editable Shows the File Size of the object. 

Modification Date Read-only Shows the Modification Date of the object. 

Archive true/false Editable Shows the Archive property of the object. 

Read Only true/false Read-only Shows the Read Only property of the object. 

File Access Method Enumerable Read-only Shows the File Access Method of the object. 

Md5 Hash String Editable Shows the Md5 Hash property of the object. 

Fwu Apply Upgrade true/false Editable Shows the Fwu Apply Upgrade property of the object. 

Firmware Activation Time Firmware Activation Time Editable Shows firmware activation time. 

Actions

•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.
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Network Port

Step 1.	 Drop this object from device on to the TRC Controller's config space,object gets uploaded as soon as it is dragged on 
config space.

Step 2.	 Configure and save its editable properties from the TRC Property sheet and invoke the Download All action on the TRC 
Controller to download the object to the controller.

Step 3.	 Observe the download related error in the fault cause. 
 
NOTE: Niagara type is Network Port for IP and MSTP network port objects. Network port object will have all properties 
related to IP and MSTP. If device is connected over IP, then during download it will skip downloading MSTP related 
properties and when device is connected over MSTP, then it will skip downloading IP related properties.

Step 4.	 The visibility of the FD BBMD Address and Foreign Device Subscription Life properties depends on the BACnet IP Port 
Mode setting. When the mode is Normal, these properties are hidden; when set to Foreign, they become visible. After 
changing the mode to Foreign, refresh the view to display the updated properties.

Network Port Property Sheet
Figure 31.	 Network Port property sheet
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Property Value Description 

Poll Frequency range[Fast, Normal, Slot] Editable Defines the polling frequency. This property is effective only when 
polling is enabled.(shouldPoll is true) 

Should Poll true/false Editable Set it to true, if polling of this object is required. 

Status range[Ok, fault etc]. Read Only Shows the status of the object. 

Fault Cause String Read Only Shows the cause of the fault during download. 

Object Id Object Identifier Read Only Uniquely identifies the object in controller.This is set in following 
scenario: 

• When existing object is uploaded from the controller.(using 
device.uploadAll action) 

Object Name String Read Only Name of the object in controller. 

Object Type Network Port Read Only Type of the object. 

Profile Name 10-TRC-NetworkPort Read Only Name of the profile. Properties of the object varies based on 
profile of that object. 

Status Flags range[Alarm, Fault, overridden, Out-of-
Service] Read-only. 

Status of the object in controller. 

Out of Service true/false Read Only. Marks the object as out of service. 

Reliability range[refer BBACnetReliability enum] 
Read Only 

Shows the current value of reliability. 

Changes Pending true/false Read Only. This property represents Changes Pending. 

Protocol Level BACnetProtocolLevel Read Only. Protocol Level of the object. 

Network Type BACnetUnsigned Read Only. Network Type of the object. 

Network Number BACnetNetworkType Read Only. Network Number of the object. 

Network Number Quality BACnetNetworkNumberQuality Read 
Only. 

Network Number Quality of the object. 

Apdu Length BACnetUnsigned Read Only. This property represents Apdu Length. 

Ip Dns Server BACnetOctetString Read Only. This property represents Ip Dns Server. 

Ip Dhcp Enabled true/false Read Only. This property represents Ip Dhcp Enabled. 

IP Address String Read Only. This property represents IP Address. 

IP Subnet Mask String Read Only. This property represents IP Subnet Mask. 

IP Default Gateway String Read Only. This property represents IP Default Gateway. 

BACnet IP Udp Port integer Read Only. This property represents BACnet IP Udp Port. 

BACnet IP Mode Enumerated Editable This property represents BACnet IP Mode. 

FD BBMD Address String Editable This property represents FD BBMD Address 

Foreign Device Subscription 
Lifetime 

integer Editable This property represents Foreign Device Subscription Lifetime. 

mac Address BACnetOctetString Read Only. This property represents mac Address. 

Max Master BACnetUnsigned This property represents Max Master. 

Max Info Frames BACnetUnsigned This property represents Max Info Frames. 

Actions
•	 Upload Object: Upload the object’s properties from the controller.

•	 Download Object: Download all its configured properties to the controller.If the network type is IP, all IPrelated properties 
will be downloaded; if the network type is MSTP, then MSTP-related properties will be downloaded.

•	 Activate Changesivate Changes: Applies the current value of Max Master(MSTP)/Max Info Frames(MSTP)/BACnet IP 
Port(IP)/FDBBMD Address(IP)/Foreign Device Subscription Lifetime(IP) to the controller.
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